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Overview

The Blue Terminal program is a simple serial terminal with extra buttons to assist with testing and setting up
Bluegiga Bluetooth modules. The name Blue Terminal is the short form of BlueTooth Serial Terminal. This
help can also be found at esdn.com.au/Help

When run, the program will appear as shown below. On the first run, the COM port should be set to the
COM port which is active, and the baud rate should be set to the appropriate rate. The status of the serial
connection will be shown in the lower left part of the status bar as:

·  Online for a successful connection or 

·  Offline for an unsuccessful connection. 

The settings are saved to and loaded from the Registry when the File is Closed or Opened.

Registry Settings
Various settings and values are saved to the Registry when BlueTerminal is closed. These settings are then
reloaded when BlueTerminal is restarted. 

Disclaimer: Do not use a registry editor to edit the registry directly unless you have no alternative. The
registry editors bypass the standard safeguards provided by administrative tools. These safeguards prevent
you from entering conflicting settings or settings that are likely to degrade performance or damage your
system. Editing the registry directly can have serious, unexpected consequences that can prevent the
system from starting and require that you reinstall Windows . 

The settings are saved to the registry under the name \HKEY_CURRENT_USER\SOFTWARE\BlueTerminal.

http://esdn.com.au/Help/toc.html
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Free Version
The Free Version is identical to the Pro Version of Blue Terminal except for a 30 secnod dleay on changing
any parameters.

In the Free Version, COM1, COM2 and COM3 may be used without the timer. The timer is added to
encourage frequent users to upgrade to the Pro version of Blue Terminal.

Bluegiga interface

Blue Terminal allows for efficient testing of BlueGiga bluetooth modules. Press the S or SET button to view
all the settings. Alternately, the mouse can select the lower  screen, and the operator may type in SET
followed by the ENTER key.

Menu
Menu

There are six menu headings:

· File - to select File and Print operations

· COM - Select or Autodetect the correct Com Port

· Parameters - select the Com Port parameters such as baud rate, parity or data bits.

· View - turn on various customised toolbars or options to setup Bluegiga iWrap profiles easily

· Commands - some commonly used Bluegiga iWrap commands

· Help - activate this context-sensitive help

File
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The File Menu has the following selections:

· Clear - clear the screen

· Copy - copy the screen data to the clipboard

· Log - turn the file logging on or off - the filename is shown on the status bar

· TimeStamp - Add a timestamp to the log file

· DateStamp - Add a datestamp to the log file

· Download File - send a file through the serial port in ASCII format (useful for EEPROM Emulator device)

· Print Setup - Change the Print Properties

· Print - Print as Black on White to any printer

· Exit - Close the Blue Terminal session

COM

Select the Com port to connect to. If unsure, select Autodetect and select the Com port from the drop down
list of active Com ports. COM port 1 to 100 are supported - while Windows allows COM ports from 1 to 255.
The COM ports from 21-100 are found in the respective submenus.
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Parameters

Parameters

Select the baud rate from one of the available baud rates.

Also select the parity, databits and stopbits. These settings along with the Com port selection are saved to
the Registry on exit.

The Timeouts screen allows for the Comm Port timeouts to be adjusted.
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Timeouts

The Timeouts screen allows for teh CommPort Timeouts to be adjusted and set.

These timeouts affect how fast Blue Terminal will react to incoming and outgoing serial data. Please note
that the Timeouts should be nonzero, otherwise lockup situations may occur where Blue Terminal cannot
read the serial data when devices are plugged in and out repeatedly.

View

View - toggle on or off the toolbar of special modes

· SPP (BlueGiga Serial Port Profile) toolbar

· BGIO (BlueGiga IO Profile) Toolbar

· HID (BlueGiga Human Interface Device) Toolbar

· Echo mode - echo all characters on the screen
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· Hex mode - view all incoming characters in hexadecimal mode

· Hex Write - send out characters in hexadecimal format (with a space) (this can be done by typing in
the data window or use the Send button)

· Unreadable - view unreadable characters (eg most characters below 0x20) when checked, or display in
hex mode if turned off (default)

· Green on Black - use the original colour scheme of Green Text on a Black background similar to the old
Wyse terminals (see lower picture)

· Copy to Send - any commands sent out the Serial port will be copied to the Send box. For example,
pressing the S button will copy SET to the Send box. This allows for an easy way to see what data is
being sent out the serial port, and allows data to be repeatedly sent out or modified

· Add Linefeed to \n - useful when receiving data which is only terminated with a \n not a \n\r such as from
Arduino

· iWrap Commands - add a list of iWrap commands which can be clicked on to send the command to the
module
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Commands

Commands

These are some common shortcuts for commands. The baud rate commands will change the Blue Terminal
and Bluegiga device simultaneously to the new baud rate.
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To View the commands, select the View|Copy To Send and the commands will appear in the SEND box as
they are sent out.

9600, 19200 ... 115200

The commands 9600, 19200 and so on will change the baud rate to the selected value. Before this, the
BlueGiga command will be sent out SET CONTROL BAUD xxxx command will be sent which will change
the baud rate on the BlueGiga device to the selected baud rate. Then the baud rate of the computer wil
change and the SET command wil be sent out. So the process is:

1. Change BlueGiga baud rate using SET CONTROL BAUD command
2. Change computer baud rate
3. Send out SET to confirm the baud rate changes were successful

UART LATENCY

UART LATENCY sends out SET CONTROL CONFIG 4000

CONTROL CONFIG

CONTROL CONFIG sends out SET CONTROL CONFIG LIST

SET BT SNIFF

SET BT SNIFF sends out SET BT SNIFF 4 2

SETBTPAIR*

Press the SET BT PAIR * to clear all the previous pairings.To enable pairings, the SET BT SSP 3 0
command must bee issued first.

AUTOCALLOFF

The AUTOCALL OFF button issues the SET CONTROL AUTOCALL command which turns off autocall
mode.

HID Test

Send out 50 lines of 

0. 123,456,789
1. 123,456,789
2. 123,456,789
...
50. 123,456,789

Help

Help

· Show Help - View the help or simply press F1

· About - view the About screen (shown below)
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Popup Menu
The Popup Menu appears when the data area of the window is right clicked. This provides quick access to
the most common commands of Clear, Copy, Paste and Print.

Toolbar buttons
Toolbar Buttons

There are several toolbars provided to help with interfacing to BlueGiga and Gainspan modules. These
toolbars are:

· Standard toolbar

· SPP profile toolbar for Serial Port Profile
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· BGIO profile toolbar for BlueGiga IO Profile

· HID profile toolbar for Bluegiga HID Profile

· Gainspan Toolbar

SET

Press the S or SET button to view all the Bluegiga settings.

SET
SET BT BDADDR 00:07:80:89:88:f5
SET BT NAME WT12-A
SET BT CLASS 001f00
SET BT IDENT BT:47 f000 4.0.0 Bluegiga iWRAP
SET BT LAP 9e8b33
SET BT PAGEMODE 4 2000 0
SET BT POWER 3 3 3
SET BT ROLE 0 f 7d00
SET BT SNIFF 0 20 1 8
SET BT MTU 667
SET CONTROL BAUD 115200,8n1
SET CONTROL CD 00 0
SET CONTROL ECHO 7
SET CONTROL ESCAPE 43 00 1
SET CONTROL GAIN 0 5
SET CONTROL MSC DTE 00 00 00 00 00 00
SET CONTROL PREAMP 1 1
SET CONTROL READY 00
SET PROFILE BGIO Bluegiga IO
SET

RESET

Press R or RESET (or type in RESET and Enter) to perform a soft reset of the Bluegiga device. Note that a
hard reset may be accomplished by typing SET RESET and ENTER

RESET
WRAP THOR AI (5.0.2 build 764)
Copyright (c) 2003-2013 Bluegiga Technologies Inc.
READY.

INQUIRY

Press the I for INQUIRY button (or type in INQUIRY 5 NAME) to send out an inquiry command for 5
seconds, reporting the name of all bluetooth devices found. If the result of the Inquiry is 0 but bleutooth
devices are available, check the Pagemode setting of the Bluegiga devices, or the visibility setting for non-
Bluegiga devices.

INQUIRY 5 NAME
INQUIRY_PARTIAL 00:07:80:81:4d:3d 001f00
INQUIRY 1
INQUIRY 00:07:80:81:4d:3d 001f00
NAME 00:07:80:81:4d:3d "WT12-A"
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LIST

Press L for LIST (or type in LIST and Enter) to list the current connections of the Bluegiga device.

LIST
LIST 1
LIST 0 CONNECTED RFCOMM 666 0 0 30 8d 8d 00:07:80:81:4d:2c 1 OUTGOING ACTIVE MASTER PLAIN
0

MAC Address

The MAC Address combo box saves all the MAC addresses which are found using the INQUIRY command.
The selected MAC Address is then using in all CALL commands. To select the device to connect to, select
the correct MAC address from the combo box.

Send

The Send Edit Box and button allow commands to be sent out. This is useful if repeated command need to
be used, or if data needs to be sent in Multiplex mode. Note that a carriage return is appended to the sent
data.

SELECT

The SELECT button will select an open connection with the selected channel

CLOSE

The CLOSE button will close a connection on the selected channel. 

SET OUTPUT

The right arrow button sets the Bluegiga device IO to all outputs, using the command PIO SETDIR FF FF

OUTPUT ON

The ON button sets the Bluegiga device IO to ON, using the command PIO SET FF FF

OUTPUT OFF

The OFF button sets the Bluegiga device IO to OFF, using the command PIO SET FF 00

Multiplex Mode

Select the MUX Mode checkbox to turn on Multiplex mode. In multiplex mode, the command string is
wrapped inside a control packet. The advantage is Multiplex mode is that simultaneous communication
command can be sent to any of 7 open channels.

When the MUX mode checkbox is checked, the command SET CONTROL MUX 1 is sent out, to place the
Bluegiga device in Multiplex mode. When the MUX mode checkbox is unchecked, the command SET
CONTROL MUX 0 is sent out in multiplex mode, to turn off the MUX mode. 

SET CONTROL MUX 1
<BF><FF><00><08>READY.
<00>

SPP ToolBar
SPP Profile
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The SPP Profile is the Bluegiga Serial Port Profile

Call SPP

Call SPP, will initiate a SPP connection attempt using the following code, with <MAC ADDRESS> being the
MAC address found inthe MAC combo box by using the Inquiry comand

CALL <MAC ADDRESS> 1101 RFCOMM
CALL 0

SPP Autocall

SPP AUTOCALL will turn on the SPP AUTOCALL feature to allow the Bluegiga device to call any paired
devices once every 5 seconds. To turn AUTOCALL off expand the window and use the AUTOCALL OFF
button in the standard toolbar.

SET CONTROL AUTOCALL 1101 5000 RFCOMM

SPP ON

The SPP ON button turn the SPP profile on with the command below:

SET PROFILE SPP ON

SPP OFF

The SPP OFF button turn off any SPP profile by issuing this command:

SET PROFILE SPP

SSP 3 0

The SSP 3 0 command execute the SET BT SSP 3 0 command which allows for pairing of Bluegiga
devices. This is only available in iWrap 4

PAGEMODE

The PAGE MODE button executes the SET BT PAGEMODE 4 2000 1 command.

CMD/DATA

The CMD/DATA button switches between command and data mode. When a serial port profile (SPP)
connection is made, the Bluegiga device automaticaly goes into data mode. This means that all data is sent
through the connection and commands such as SET cannot be execute. To switch out of data mode, enter
+++ or enter the escape character three times with a 1 second delay before and after. When the Bluegiga
devices responds with READY, the device is now in command mode.

BGIO ToolBar
BGIO Profile (Bluegiga I/O Profile)

CALL BGIO

CALL BGIO willl call and connect to a BGIO profile. The Master device should be set to a SPP Profile, and
the slave device should be set to a BGIO profile.
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BGIO Autocall

BGIO AUTOCALL will issue the command to setup the Bluegiga device to autocall usingthe BGIO Profile.

SET CONTROL AUTOCALL af5c7d47-350b-45f6-bdf6-b403441edb77 5000 RFCOMM

BGIO ON

The BGIO ON button will turn onthe BGIO profile by issuing this command:

SET PROFILE BGIO ON

BGIO OFF

The BGIO OFF button turn off any BGIO profile by issuing this command:

SET PROFILE BGIO

SET DIR

The SET DIR command will set teh remote BGIO device to be all outputs by issuing this command:

<00><05><07><FF><FF><FF><FF>

SET PIO

The SET PIO command will turn on the remote BGIO device outputs by issuing this command:

<00><05><04><FF><FF><FF><FF>

CLR PIO

The CLR PIO command will turn off the remote BGIO device outputs by issuing this command:

<00><05><04><FF><FF><00><00>

HID ToolBar

CALL HID

CALL HID will issue the command CALL <MAC ADDRESS> 11 HID. An Inquiry command should be done
first to determine which MAC address shoudl be used.

PAIR

PAIR will call the command PAIR <MAC ADDRESS>

HID ON

HID ON send out the command below to the bluetooth module:
SET PROFILE HID Keyboard

HID OFF
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HID OFF send out the command below to the bluetooth module:
SET PROFILE HID

GainSpan ToolBar

Version
Send out AT+VER=?

Status
Send out AT+NSTAT=?

DHCP Enable
Send out AT+NDHCP=1

ScanTime
Send out ATS5=999

Scan
Send out AT+WS

Disconnection and Reconnection

When a COM device is removed, the Blue Terminal program will automatically detect this, and change the
status in the Statusbar to COMx - Offline. When the same device is reconnected, Blue Terminal will
automatically reconnect the device and change its status to Online with the same parameters and show this
is the Statusbar. Thre reconnection process will take from 5-10 seconds typically.

Data Window

The Data Window is shaded with a light shade of blue to remind the user about the benfits of using
Bluetooth.

All serial data will be displayed here (the data can be optionally displayed as Hex if needed).

To send data out, simply click the mouse inside this window and press any key to send out the ASCII data
for that key. Alternately, data may be tryped into the send box, and teh Send button pressed. This is helpful
when repeated data needs to be send out.

Right Click anywhere in the Data Window to bring up the Popup menu below.

Version info

Version Release info

 v1.00  19 Aug-2011 First release
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 v1.01  7-Dec-2011 Improve Help, Add Gainspan toolbar, timestamp, datestamp
 v1.02  9-Feb-2012 Fix Auto off/on and stop timer in Autodetct mode
 v1.03  8-Mar-2012 - Add View Hex|Write support - status bar shows Hex Write
 v1.04  30-Nov-2012 - \n or 0x0a now makes the line feed for Arduino sketches, rework Free Panel - delay
now 30s, fixup Paypal link
 v1.05  14-Feb-2013 - Added View > Add linefeed to \n option so SET does not give double line spacing,
improved Copy To Send, restored Right Click in Window
 v1.06 - 26 -April-2013 - fix for Windows64, fixup File > Log to start after file is opened, add Parameters >
timeouts
 v1.07 - 29-May-2013 - improve Windows64 startup, fixup windows icon, restore Send data, set Read
timeouts for Eterlogic Virtual Com port
 v1.08 - 4-Oct-13 - Add two extra toolbuttons to turn on 3 lights at a time, iWrap 5 change IO port to FC  
 v1.09 - 5-Dec-13 - Fixup Auto Detect, add Com ports 21-100
 v1.10 - 27-Feb-14 - Add iWrap window and View Iwrap menu item

Licensing

This version of Blue Terminal is supplied as a product for research, design, development and testing and
should not be used for any critical applications.

The free version of this program may be freely distributed. For support, please refer to www.esdn.com.au

www.esdn.com.au
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